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Use Bill and Hold when you want to record a sale to the customer now, but they will not be picking up
their product until later. The product should be in inventory (balance > 0) for Bill & Hold so that it can be

costed correctly.

E Add Invoice Purchase Row >
|uupdate |Hefresh |@Em't |

Product: |Front & Finish 2L - F&F

Units: [JUG - Jug ~]"

Location: IEdmurrtun j -

Quantity cn Hand: 200 Details I

Quantity: 30 ° ﬁ Bill and Hold

Unit Price: §75.00 ~ Pricing |

Do =a s
Line Total: | $225.00

Accounts Receivable > Invoices > Add
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Bill & Hold Business Rules

These are the business rules and best practices regarding Bill & Hold.

Product should be in-stock at the time of invoicing.

agre needs costing information to make the COGs posting, otherwise an estimated cost will have to
be used. This could cause issues if the cost changes, especially if the invoice is in a closed year or
period.

Bill & Hold status of a product row cannot be changed once the invoice has been saved.
The product row can be removed (as long as none has been taken) and added again.

The product, units, and location of bill & hold product rows can be edited, as long as there are no
deliveries against that line.

Invoice lines that have been imported from a loadout ticket cannot be set to bill and hold.
The product has already been taken on the LOT; there is nothing to hold.

Only inventory products can be set to bill and hold.
Returns cannot be set to bill and hold.

Blends and additional items in blends cannot be set to bill and hold.
Because the blends are normally blended at the time of delivery, they are not in-stock at the time of
invoicing and therefore ineligible for bill and hold.

Lot Numbers (Lot#s) are not required' for bill & hold product rows, and will be entered on the LOT
when the product is picked up or delivered.

Product must be picked up from the bill & hold location.
The Sales and COGs postings were made at the time of invoice for that location and cannot be
changed unless the invoice is changed.

As product is picked up, the LOT will indicate the Bill & Hold Invoice reference number, but the
INV will not be updated with the LOT number (as there could be multiples).

! Inventory > Manage > Products / Products Tab
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Bill and Hold Setup (one time tasks)

Security

You’ll need permission to run the data export for Bill and Hold Invoices.

v Edit RoiLo rdOfTheUniverse =N EoR(~="

& save Delete @ Exit
"Role  Pemissions I t

" Accounts Receivable ] Invertory l Accounts Payable | General Ledger | Blending | Agronomy  Administration |

ltem Action Allow? Deny? - Allow All

Export Data Enable an menu [l (i
AR |nveice Summary il ] n Deny All
| Eill And Hold Invoices ' =
TS S Marmne T vl =1 i Clear All

File > Security > Manage Roles

Company Configuration Option

Activate Bill and Hold in the Company Config Options and save your changes.

% Company Level Settings El@
|nSa\re ‘ﬂ it '

" General| Accounts Recsivable | Blending ] Accourts Payable ] Inventony ] Agrc

Invaices | Loadout Tickets ] Work Orders ] AR Payments ] Customers ]

¥ futomatically generate Reference Mumber
¥ Automatically generate Reference Mumber (IOL Invoice)
¥ Offer to Import Loadout Tickets
[ Offer to Impart \Work Orders
v Offer Early Payment Discount
[ EPD: Omit Blends
[ ¥ Alow Bill and Hold |

File > Config Options > Company > AcctsRec > Invoices
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Adding a Bill and Hold Invoice

When adding products to the invoice, flag them as Bill and Hold (also flag them as Prepay if they are

prepaid).

</ Add Invoice Purchase Row
JO Update |F{efresh |6Em't |

=

Product: |GREENGRO - Green GRO
Units: [JUG - Jug ="
Location: IDOQ River Ll i

Quantity on Hand: 3450 Details |

Quantity: I 30 -

Iv Bill and Hold

Unit Price: I sB00 ° Piang | W Prepay?

~]° Find |

Line Total: | 5225.00 y
Invoice > Add
The product is flagged as Bill and Hold on the invoice.
& Edit Invoice: DINV165 = =]
J n Save | X Delete | Refresh | Histary | -‘( View Credit | View Prepayment Report |® Exit |
Reference: IDINV‘IG& : Location: IDog River Ll i
Customer:  Carter, Alander (00183) ~|" Fing | Add | Created By: [agre User
Invoice Date: [Nov 05,2013 ~| DueDate: |Dec31,2013 =] Invoice Total: | $225.00 |
" Customer and Shipping  Purchases (1) | Retums I Totals I Immediate Payment I
| Product | Quantity|  Unit Price| Taxes | Line Total | Prepay?|| Hold? [Location | WO Ref LOT Ref|
> |GREENGRO - Green GRO (JUG) | 30| 575.00| 50.00| 5225.00] | Dog River | |
Purchases Subtotal (before tax): $0.00 AddProductRow | AddBlendRow | EdtRow |  RemoveRow |

Prepaid Purchases (before tax): $225.00
Prepayment Remaining: 554 508.33

Import from WO/LOT | Auto Link to WO | Link to Work Order | Uze Remaining Frepayment |
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Sales and COGs (based on FIFO) postings are made immediately upon saving the invoice, even though the
inventory hasn’t moved yet.

postings generated from
Bill and Hold invoice

a.gr-e_ Tronia Testing Inc.

Posting Details

DINV165
Journal: J2179 Posted: MNov 05, 2013
Source: DINV165 Entered: Mov 05, 2013
Description: AR Invoice: Alexander Carter
Account DR CR Description
Accounts Receivable (11210) 225.00
Sales Chemicals (45015) 22500 Dog River
Journal: J2286 Posted:  MNov 05, 2013
Source: DIMV165 Entered: Mov 08, 2013
Description: Invoice DINV165, GREENGRO
Account DR CR Description
COGS Chemicals (55015) 180.00 Dog River
Chemical Accruals (16015) 180.00

,‘\w\VL!M Ten A, . _#M ae_andl ol o _LM B |  r yp |
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What Have | Got on Hold?

Reporting - Bill & Hold

The Bill and Hold report will tell you who has/had product on hold, how much they’ve taken, and how
much they have left to take. You can group by Customer or by Product.

agre

Tronia Testing Inc.
Bill And Hold

Customer is Wallace, Ted [(1051); Sorted By Customer

Ted Wallace (1051)

Invoice Date Product Unit Price
SAIMVET Maov 10,2014 Achieveliguid Gold (CASE) 5850.00
SAINV30 May 28, 2014 Drop Dead Dandelion 1L (JUG) 817.50
DIMY182 Mov20,2013 Mo’ Betta (BOX) 5400.00

Quantity
1.00 3850.00

1.00 217.50
2.00 3800.00

Quantity Quantity

Total Taken Remaining
0.00 1.00

1.00 0.00

2.00 0.00

Accounts Receivable > Reports > Bill & Hold (or Customer Account)

Reporting - Inventory Position

et gt . an x_\“.__.ﬂ ,L______r'\ - -d _'n-.ﬂ'* EWRET R S ey A o e

The Bill and Hold layout of the Inventory Position Report will let you know how many you have on hold

for each location.

a'gre click a link for
more details

Inventory Position
Company with Location Details

Product Name is GREENGRO - Green GRO

7z
Chemicals /
( Min
Product Units Location Level
Green GRO (GREENGRO) Jug Dog River 0.0

Edmeonton 0.0

Qty On
Hand
2450

240.0

Qty
Ordered
0.0

0.0

Qty
Committed
0.0

0.0

Qty
OnHold
6.0

0.0

Qty
Available
339.0
240.0

Totalk

R T e ¥ LW SR wlr SN 2V W e N P A ot o et

383.0

0.0

Inventory > Reports > Inventory Position

0o

6.0

379.0

Note The Bill and Hold version of the Inventory Position report can be loaded into

your agré database.
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For more details - like WHO has it on hold - click a product or location link. These are the details for Dog
River.

agr'é Inventory Position Detail

Company with Location Details

GREENGRQ - Green GRQ (JUG)
Dog River

Inventory on Hand

Document Reference Date Name Quantity Rremaining
Inventory Recsipt 1578 Mar 01, 2012 Baker's Ag Supply 185.00
Inventory Receipt 1878 Mar 01, 2012 Baker's Ag Supply 180.00
Inventory on Hand 345.00

Inventory on Hold
Document Reference Date Name Quantity Remaining
I oice DINV1ET Oct 09,2013 Carter, Alexander (00133 3.00
Invoice DINW1 85 Mov 05 2013  Carter, Alexander (00r183) 3.00
Inventory on Hold 6.00
Dog River 339.00

*M’\r#"‘ b A i o o et . R B e b ke et e, ol

Tip The Inventory Position report tells you how much you are currently holding
and for whom. If you want quick details about product that was on hold, but
has now been picked up, check the Bill and Hold Invoices data export or the
Bill and Hold report.
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Data Export - Bill and Hold Invoices

The Bill and Hold data export gives you the same information as the Inventory Position report, with extra
details about product that was on hold but has already been picked up.

v Export Data [E=n E=H ==

JE:porttoHle |+|EE:quntoExcel ‘F‘reviewData ‘6501 |

Select the data you want to exportipreview?
B-C) Eqorts ~ r— Criteria

EI{EJ Accounts Receivable Start Date: Iﬁd 05,2013 =

AR Invoice Summary

Bill And Hold Invaices End Date: INov 05, 2013 'I

Chemical Sales Summary (AB Env.)

¥ Include Header Line

m

CRIM Custom Attibutes Product Type: Iﬁny Product Type ;I
Customer Balances Customer: I(.Pu-ry Characteristic: ;I
Customer List

Customer Mailing List -

File > Exports > Data

> Bill And Hold Invoices ==
ICEY
Simple |J\d\ranced |
Date | F{efereruxl Line Locatic| Customer Code ‘ Last Name | First Name | Product Code | Product ‘ Unit Type | Product Type | Unit Price ‘ Unit Cost ‘Quantity ‘Qw Shipped |QWOn Hold
|| 10872013 DINVI56 Dog River 00183 Carter Alexander DDD Drop Dead Danc Jug Chemicals 10.0000 100.0000y  3.0000 3.0000 0.0000
| 10272013 DINVI57 Dog River 00183 Carter AMlexander GREENGRO  Green GRO Jug Chemicals 70,0000 60.0000y 7.0000 7.0000 0.0000
11/5/2013 DINVI65 Dog River 00183 Carter Alexsnder GREENGRO  Green GRO Jug Chemicals 75.0000 60.00004 3.0000 0.0000 3.0000

Select All To copy selected cells press Ctrl + C.
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Picking Up Held Product on a Loadout Ticket

When the customer is ready to take their product, create a new Loadout Ticket.

You will be reminded that they have product on hold. Click Yes to Import from Bill and Hold.

-

¥ Add Loadout Ticket
JHSave ‘ Refresh ‘ ‘{ View Credit |'@ Exit |

(= [=E=]

Reference: I * ¥ Generate Reference Automatically

Customer: |Carter, Alexander (00183)

Date: INcw 05,2013 | °

~|" Find | ndd | Location

|Dog River

Created By: IEIQI'B User

Customer and Shipping  Preduc] Import From Bill and Hold?

| Product (Delivered Unit; P

=

This customer has inventory on held. Would you like to import?

Units

Aut. Blender

Add Product Row | AddBlendRow |  EditFlow | Femove Fow |

Import WO./Eil & Hold || futolink o WD | Link toWork Order | import from Field Scout |

Tip

Hold later to bring up the same window.

If you click No and change your mind, you can always click Import WO/Bill &

Click Bill and Hold. Check which product(s) is being taken, and how many, then click Use Selected Rows.

€ Any Date € Datef may default to quantity remaining but can

@lport Rows (==
J b Use Selected Hov%'j Preview tem |6 Exit |
— Filter 0 Impart
 AnyProduct " This Product: I::Start typing or use find> LI Find | 1] ) © Bill and Hold
BRI A Podt Bl ey i product is being taken [P " Vlork Orcers
depending on config options, the quantity Refrash List |
-]

(2'\. be edited to less (but not more)
\r/lmport Qty rod
iy 30
] Now 05, 2013 | GREENGRO - Green GRO (JUG)
the same product can be on
Select All | Desslect Al 2lnvel mare than one Bill&Hold invoice y
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The product is added to the LOT and is flagged as already billed. Save the LOT.

M Add Loadout Ticket = =N
J Es@j%ij Refresh ‘ & View Credi |6 Bxit |
by .
Reference: I ¥ Generate Reference Automatically
Customer: ICarter. Alexander (00183) LI * Find | Add | Location: IDog River LI -
Date: INm: 05, 2013 hd I . Created By: |E|gre User
Customer and Shipping  Products I Additional Information |
Product (Delivered Units) Quantity | WO/Invoice Ref | Location Eilled? ||Billing Units Aut. Blender
> |GREENGRO - Green GRO (JUG) 3.0| DINYV157 Dog River HUG - Jug
Add Product Row |  AddBlend Row | EdtRow | Remove Row |
Import WO./Bill & Hold I Auto Link to WO | Lirk. ta Wwiark Order | Import from Field Scout

The LOT report displays the Bill and Hold Invoice reference number.

agre

Dog River, SK S0K 1T9
306.552.1903
Mobile: 306.457 9963

Date: Nov 03, 2013 Loadout Ticket: DLOT154
Alexander Carter (00183)

Box 14 Ship To:

#7 Arden County Road Box 14

Tronia Testing Inc.
782 Rainbow Road

Dog River, SK 38H 1AQ0

Phone: 306.655.1625

Fax: 308 555 5281

Toll Free: 800.123.4887

#7 Arden County Road
Dog River, SK S0K 179

Product Quantity Units Location Work Order
Green GRO (GREENGRO) ,‘ 3.0000 Jug DogRiver
Bill and Hold Ref#DINV157
The Loadout Ticket grid lists the Bill and Hold Invoice reference number.
¥ Loadout Tickets = =R

J =+ Add ‘f Edit ‘ 75 Delete ‘M Mew Search Preview kem = | £7 lvoice -

E] History ‘eEmt |

Customer

Carter, Alexander

1 Loadout Ticket found

« | Ticket Date

Location
Now 05, 2013 | Dog River

Loadout Ticket Number
DLOT154

Billed || Bill and Hold | Invoice

DINV157

AR Bill and Hold
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Now that the product has been taken, asset value is updated accordingly.

agre postings generated from Tronia Testing Inc.
Bill and Hold loadout ticket . .
Posting Details
DLOT154
Journal: J2289 Posted:  MNov 05, 2013
Source: DLOT154 Entered: Mov 08, 2013
Description: Loadout Ticket: -3 Jug Green GRO (GREENGRO)
Account DR CR Description
Chemical Accruals (18015) 180.00
Chemicals (15015) 180.00

“rmantlin. o gt tnanlll S am o st At n ol e Al i At Pt T i gt i i ettt |

Bill & Hold Q&A

What if my customer needs to pick up from a different location?

When the Bill & Hold invoice was created, sales and COGS postings were made based on the FIFO cost
for that location. These postings can be changed only by making changes to the invoice.

Because of this, when product is picked up it must be loaded out from the same location as the invoice —
it can’t be edited at this time (you’d need to edit the invoice first, to select a different location, before
creating the LOT).

-

¥ add Loadout Ticket i =N
: location where the customer =iEE]
Reference: I—* V¥ Generate Reference Automatically \
Customer: |Carter, Alexander (00183) =" Find | Add | Location  [Parkiand Warehouse B

Date: [ a2 =] © Created By: |agre User

Customer and Shipping  Products I Addtional Information |

Preduct [Delivered Units) Guantity | WO/lnvoice Ref | Location Billed? | Billing Units At Blender
> | ACHIEVE - Achieve Liquid Gold (CASE) 1.0/ DINVZ10 Dog River CASE- Case
Add Product Row | Add m[ s Edit Loadout Ticket Product - Row 1
o Jg Update |He{|-esh |QE,G-1 | product, units, & location I
location on the Bill & cannot be changed 1
] Hold invoice Product: JACHIEVE - Achieve Liquid Gold —

Loadout Ticket Units: |CASE - Case ~]°

[Pog River |7 sheifs: 18

Imvoice Ref: DINVZ10

Location:
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If you can’t edit the invoice (maybe it’s in a closed year, or some product from that invoice row has already
been taken so it can no longer be edited, or it’s just not your business practice to do so): after the customer
picks up elsewhere, create a Location Transfer and transfer the amount taken from where the product was
actually picked up to where it was supposed to be picked up.

%~ Add Location Transfer =nE=R =
|nSave | L]StartOver ‘QE:U’( ‘
Reference: * ¥ Generate Reference Automatically
Transfer From: JF‘arkIand Warehouse ﬂ * Transfer To: JDDQ River j :
Transfer Date: Jul 14, 2014 ﬂ B
I
where the product was where the product was
actually picked up supposed to be picked up
— - I
Freight Terms: J
Product Quantity | Status |
> | ACHIEVE - Achieve Liquid Geld (CASE) 1.0000| Complete [~ |
Add Product Row | Edit Product Row Remave Product Complete Al |

The location transfer keeps inventory levels accurate.

What if my customer didn’t take all their Bill and Hold inventory?
If you billed your customer for more product than they ended up taking, there’s two ways to handle it.

1. The preferred method - and the easiest - is to edit the Bill & Hold invoice and reduce the quantity to
what they've actually taken. The customer's chargeable balance will be reduced accordingly.

& Edit Invoice: DINV348 ===
| n Save | X Delete | Refresh | Split | History | @ View Credit | View Prepayment | View WO Activity |® Exit |
Reference:  |DINV348 = Location: Dog River -
| theybought 2 L—J' i ocahon ]I = =
Customer:  |Carter, Alexander (001 units, but they - Find Add .
Invoice Date: [Dec 15,2015 ~|  tookonly 1 Brzo. -] Edit Row ol | 5170000 |
change quantity to 1

" Customer and Shipping  Purchases (1) ] Retums ] S‘als ] Immediate Payment ]

| Product | tity| Unit F'riDe| Taxes | Line Total | Prepay? | Hold? \Dcatinn |WD Ref | LOT Ref|
> | ACHIEVE - Achieve Liquid Gold (CASE] 20|  s850.00] 50.00| 5170000 [0 | | DhgRiver | | |
Purchases Subtotal (before tax): §1,700.00 Add Product Row | Add Blend Row | Edit Row | Remove Row |
picpaidlQiachasesibeintegax) S Import from WO/LOT | Auto Link to WO | Link to Work Order | Use Remaining Prepayment |

Prepayment Remaining: 5118.353.97
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2. Ifyou don't want to - or can't - edit the invoice (maybe it’s in a closed year/period or it’s just not part of
your business practice) then create a new LOT and take the quantity remaining on Hold.

¥ Add Loadout Ticket [=][@ | =]
JﬂSave ~ | [} Documents Refresh ‘ B View Credit |® Exit |
Reference: I * ¥ Generate Reference Automatically
Customer: ICarter. Alexander (00183) LI * Find | Add | Location: Ich River LI -
Date: [Verzmame ~] © Created By: |agre User
Customer and Shipping  Products IAdd'rtionaI Irformation |
1
% Import Rows
b Use Selected Rows | Preview tem |e Exit |
I
r Filter ——— Impaort
import remaining | P
& Any Py quantity (the amount not |byping or use find> ~|  Find | & Bill znd Held
being taken) from Bill & ~
Product Ty - ] I Include Associated Products Work Orders  [#
Hold invoice
" Any D WES|DEEUT. 2015 x| to [Mar23 2016 x| Refresh List |
Import Qty | Reference Quantity| Qty Taken| Unit Price | Prepay? | Location
Dec 15, 2015 | ACHIEVE - Achieve Liquid Gold (CAS 585000 No Dog River

Add another product row for the NEGATIVE amount (so net quantity would = 0).

¥ Add Loadout Ticket E=n EER ==
| B sove | [ Befresh |  view Cresit | Bt |
Reference: I * ¥ Generate Reference Aut
T ——— add a second row for the R -
Customer: I arter, Alexander | ) same product and quantity, [ | og River LI
Date: IMar 23,2006 =] but make the quantity By: agre User
negative (a return)
Customer and Shipping  Products |Add'rtional Infi ion I
P
Product (Delivered Units) Quantity WU.l’Invpié Ref |Location Eilled? | Billing Units Aut. Blender
ACHIEVE - Achieve Liguid Gold (CASE) 1.0 W& Dog River CASE - Case
> | ACHIEVE - Achieve Liguid Gold (CASE) -1.0 Dog River [&] CASE - Caze

Bill the return (the "take" is already billed on the bill and hold invoice) at the same price as on the
B&H invoice; the customer ends up with a credit on account.

</ Add Invoice EI@
Jﬂgave | [Z] Refresh |Sp|'rt_ | & View Credi |\new Prepayment |\c"|ewWOAdi\r'rty |®Egt |
Reference: I * ¥ Generate Reference use the same pri ce Location: IDog River LI o
Customer: ICarter. Alexander (00183) as on the Bill & Hold :_I Created By: Iagre User
Invoice Date: | Mar 23,2016 = |~ DueDate: | Apr 30 invoice Invoice Total: | ($850.00) |
Customer and Shipping I Purchases : i [ diate Payment I
| Product [ Quantity | Unit Price | Taxes | Line Total | Prepay? |Location [ LOT Ref
> | ACHIEVE - Achieve Liquid Gold (CASE) | 10| 585000 | £0.00| (85000)| [ |DogRiver [ DLOT220/

Costing Implications with Either Method - if the cost has changed since the B&H invoice, the quantity
not taken/returned will have a different cost. You may want to play with Inventory Return Costs or Cost
Reallocation (since the product never actually left the building those cost row should have been available

for other transactions).
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